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INTRODUCTION 

This suite of applications allows you to use your PC to graphically create 
multiple ringing schedules, synchronize the clock, back up schedules and 
settings and keep the operating system up to date.  In addition, advanced 
capabilities that would add complexity to the easy to use front panel menus 
are unlocked in the applications that are provided in the Premium version of 
the software. 

Please follow all installation and connection instructions below before 
attempting to use this software. 

INSTALLATION 

If you ordered the Premium Management Suite with your Chime Master product, 
your package should have included an installation disc, this manual and a USB cable. 
Carillons with a front panel SD card slot are supplied with the latest Management 
Suite version that was current at the time of shipment. We suggest you always obtain 
the latest version of Management Suite by downloading it from: 

www.chimemaster.com/download 

Do not connect the Chime Master unit to your PC with the USB cable until 
the software has been installed. This will allow device drivers to be properly 
registered for your system. 

System Requirements 

Management Suite is fully compatible with computers running under 
Microsoft Windows versions 2000 to 8 (not RT). It is also compatible with all 
Chime Master products that have a USB port. The user who runs the 
installation needs to be the administrator of the network or at least the 
administrator of the local computer to override firewall and security settings. 
A firmware update may be needed to get certain applications to work, and a 
copy of the latest firmware is supplied with the software (for systems 
supporting USB firmware updates). 

After you have finished installing the software, and run it for the first time, 
click the Update Firmware menu button to update your Chime Master 
product. 
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Installation Guide 

Installation Procedure 

1. Insert setup disc into your computer.  If Autorun does not proceed, click 
Run on the Start menu and enter <CD drive letter>:\setup.exe. If you 
downloaded the installation files from the website, open the ZIP file, drag 
the installation folder to your desktop and find setup.exe in it. 

2. The installer will guide you through the process.  Click Next. 
3. License Agreement must be read and “I Agree” selected in order to proceed. 
4. Click Next, observe selectable contents to be installed, and click Next. 
5. Choose shortcut options and click Next. 
6. Select install location and users if defaults are not desirable.  Click Next. 
7. Click Next to begin installation.  It should take no more than a minute to 

finish. 
8. After successful completion, click Close and restart the PC. 

 
Optionally Configure Windows Firewall for use with the 
Premium Management Suite and Mobile Apps: 
Windows XP 

1. Open Firewall settings by holding the Windows key while pressing R, then 
type firewall.cpl (enter). 

2. Click the Exceptions tab, click the Add Port button and enter "Chime 
Master Remote" and 6777 for the port number, and make sure TCP is 
selected. 

3. Click OK to create the exception. Click OK to close Windows Firewall. 
Windows Vista, 7 & 8 

1. Open Firewall Advanced settings by holding the Windows key while 
pressing R, then type wf.msc (enter). 

2. Click "Inbound Rules" in the left column of the window.  
3. Click, “Action” at the top of the page and from the dropdown menu, 

choose “New Rule.” Select Rule type "Port" then click Next. 
4. Select TCP and type 6777 for the specific local port and click Next. 
5. Select "Allow the connection" and click Next. 
6. When asked, “When does this rule apply?” Domain, Private and Public 

should all be checked. 
7. Type "Chime Master Remote" for the name and click Finish. Close the 

window. 
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This should allow mobile devices that connect to your local network to 
connect to the system. If you need access beyond your local area network, 
consult your IT administrator for help forwarding port 6777 of your 
Windows PC to the public internet. 

Connecting to the Chime Master System 
Using a standard USB cable, connect the smaller, square connector to the 
USB port on the back of the carillon. Connect the rectangular end to your 
personal computer.  

Whenever connecting or disconnecting this cable, Management Suite should 
be closed. 

Windows usually displays the New Hardware Wizard once the connection is 
made. After a successful installation of the software and drivers, select 
automatic installation for the driver. This will occur each time a different 
system is connected to the computer. If a notice concerning Windows Logo 
testing pops up click “Continue Anyway.”  After it is done loading, click 
“Finish.” 

If the driver does not load automatically, disconnect the carillon and try 
opening [MillDriverInstall.exe].  The default driver location is: 

C:\Program Files\Chime Master\Millennium Suite\MillDriverInstall.exe 
 

After a successful installation, locate and open the Management Suite from a 
shortcut or from a program menu.  If the connection between computer and 
carillon is detected, a “Ready” status will be displayed at the bottom of the 
menu panel. 

Synchronizing Titles 

Press the Remote Control button to test the connection between the carillon 
and the PC. You should see on your PC screen the same display that the 
carillon shows. Close the remote control window. 

The Jukebox and Scheduler applications will be easier to use if the PC has the 
titles from your music and bell-ringing library. Press the Jukebox button on the 
menu screen. From the Jukebox menu, select Titles then Get Device Titles. 
Press OK to confirm. You will see in the bottom status bar the progress of the 
title transfer process. In about a minute you should see your library titles in 
the right pane of the Jukebox window. Close the Jukebox window. 
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If your system schedule has been set up and programmed, but has not been 
backed up to this PC yet, press the Backup menu button. Follow the 
instructions on page 45 to back up your carillon setup memory.  
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MAIN MENU 

 
Main Menu for Premium Management Suite connected to the Platinum Carillon with all options. 

 

The Free downloaded Management Suite will not show all of the menu 
buttons shown above. Depending on the capabilities of your Chime Master 
system and its firmware revision, you may have fewer or additional buttons 
compared to the panel above.  

Other information pertaining to the connected carillon will be displayed in 
the upper right-hand box. A customer service representative may request these 
if you call for technical support. You can hide this box by right-clicking on the 
panel and de-selecting View-Details.

M = Model 
F = Firmware Version (MMYY) 
L = Library Catalog Version  
V = Installed Voices  

T = Tower Bells option  
R = Recording librarian option  
D = Clock Dial interface option 
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Menu Customization 

Right clicking your mouse in the button area of the main menu allows you to 
customize the menu. You can hide the details panel displayed on the right of 
the window, resize buttons and hide buttons you don’t use. The default 
button sizes are handy for a touch screen, but feel free to make them smaller 
if you always use a mouse.  

Some features require the carillon to enter a dedicated communications mode 
called USB Slave Mode. Switching between slave and normal modes may cause 
the carillon to reboot, resulting in a minute delay. The status bar at the 
bottom of the application screens indicates the current mode of the carillon. 

Always make USB connections to the carillon before starting Management 
Suite. Allow a few seconds after connecting for the drivers to load. 

Leaving Management Suite Open 

These features depend on you leaving the Management Suite main menu 
open: 

 Church Bell Remote Mobile App 
 Daily Time Synchronization to the Time Server 

If you wish to use these features, leave the menu open and lock the computer 
rather than logging out to prevent unauthorized access. You should set your 
power settings to prevent the computer from sleeping or automatically going 
to standby after a period of inactivity. 
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PREMIUM SETTINGS 

Upgrading from Free to Premium Features 

If you find that you need more features than the Free download provides, 
call us for the price of a Premium License. There is no limit to the number 
of computers you are allowed to install the software license to. If you have 
already purchased the license, the license code will be on the packing slip 
that accompanied your system. To enter the License code to unlock all of 
Management Suite’s features follow this procedure: 

1. Open the Management Suite menu on your PC.  
2. Right-click over the menu window and select Licensing. This will 

open a new, smaller window, which prompts you to enter a 
License Key.  

3. If we have emailed your key to you, highlight the Key in your 
email and right-click to copy it to the Windows clipboard. In the 
small Management Suite window, click Paste from Clipboard and 
the Key will be entered. 

4. You can also enter the key from the packing slip or printed email. 
5. Continue as prompted to exit and restart Management Suite. 
6. You should see additional menu buttons. 

Administrator Panel 

Root Directory 
This directory defaults to the user's My Documents directory for storing 
Millennium Suite files for backups and schedules. If several users login to the 
PC to schedule the bell system, they will not be able to access files saved by 
other users. You may also wish to use a network server to store your files on, 
and this can be specified here. This works best if the network directory is 
mapped to a drive letter.  

Network Time Server 
Normally the default timeservers work for the time sync function. If you do 
not have Internet access on your network or prefer to use your own server, 
enter its address and port (typically 123) and select if it uses the NTP or NIST 
protocol. 
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Mobile App Host 
The Administrator panel is also used to set up the host for mobile apps. Before 
setting up your mobile app, be sure that you have downloaded the latest 
Management Suite and updated the carillon firmware after installing the 
software. Also, be sure to configure the Windows Firewall for use with the 
remote app as described on page 6. 

To enable the host server for the mobile app, make sure the check box “Run 
host at startup” is checked. The app host will automatically start the next time 
you launch Management Suite. Write down the Address and Port shown on 
the Administrator Panel. You will need to enter them into the mobile app. 

Click the User Accounts button in the Administrator window to add a 
mobile user and assign access rights. There is no need to create complicated 
user names and passwords.  You will need to use your mobile keyboard later 
to enter them into the app. 
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Configuring Church Bell Remote Mobile App 

Download and install the Church Bell Remote app from the Play Store or 
App Store. You can easily find it by searching for Church Bell Carillon. 
Connect your mobile device to the church Wi-Fi connection. The Wi-Fi 
access point needs to be on the same LAN as the PC running Management 
Suite for them to be able to connect. 

Start the Church Bell Remote app. You will see a warning that a host has not 
been set. Touch OK and then touch the Settings menu button. Touch the 
Host menu item, then the Add button on the top right corner of the Hosts 
screen. Enter the name of the church in where the Add Host screen asks for 
Name (St John Wi-Fi), the App Host address displayed in the Management 
Suite panel, and then make sure that the Port is set to the same value. Tap the 
Ok button at the bottom of the screen. Tap the Settings button to back out to 
the settings menu, and then close it. 

If you create entries in the Hosts list, you wish to delete, press and hold them 
for the delete menu. 

When the app connects to the host PC, you will be prompted to enter the 
User Name and Password that you set up in the User Accounts 
Administration window above. Tap Log In and you should be able to ring 
your bells.   

For additional information, read the online help file accessible from the 
mobile app settings menu. 

Permissions of a User 
You may want to edit the permissions of any user, including: 
Selection Entry – ability to enter a specific song or bell function 
F1-F8 – access to the pre-programmed function buttons 
Tower Performance – use of the keyboard to perform 
Record Performance – use of the keyboard to practice 
 
For example, you may want to grant the cemetery owner across the street the 
permission to play a specific, requested song and F3 (toll) on Monday through 
Friday, and not the permission to adjust the volume.  For this individual user, 
check the Selection Entry box and the F3 box; check boxes Monday through 
Friday and adjust times if desired. 
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Error Messages 
Host Suspended - You cannot control the bell system when someone else is 
locally using the Management Suite on the host PC. Return the Management 
Suite to the Main Menu window. 

Firmware Update Required - The firmware version in the carillon does not 
support the remote app. Compatible firmware is distributed with the 
Management Suite, which us used to perform the update. 

Error Communicating - The app can reach the Management Suite host, but is 
not receiving status from the carillon. Check the USB connection and restart 
the Management Suite.
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Host may not be running - The app is not able to reach the Management 
Suite host system. 

 Did you correctly enter the IP address of the host PC? If it is assigned 
dynamically, has it changed? 

 Is the host PC running? 
 Is the Management Suite running? 
 Double check that your mobile device is connected to the same Wi-Fi 

network as the host PC. 
Connection attempt timed out - This generally involves the firewall(s) 
ignoring incoming connection requests. 

 Did you set up the port exception in Windows Firewall? See Installation 
guide on page 7. 

 Are other router firewalls preventing access? 
 If you are trying to access through the public Internet with a slow 

connection, try increasing the Connection Timeout in the app settings. 
For more advice, visit: churchbell.mobi/help.html. 
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SETTINGS 

Edit Remote Buttons 

When the system is in Standby mode (not playing, displaying the current 
time), buttons 1 through 8 can be programmed to manually trigger selections 
to play. Buttons 1 through 4 are available on the optional mini remote 
control. All eight buttons are available to the mobile app Church Bell Remote. 
In addition, all eight button programs correspond to macro codes 7901 
through 7908. You can use these macro selection codes to schedule automatic 
play of the selections programmed in the buttons, including Annual Events 
and Non-Recurring Events.   

Pull down the button code you wish to 
program F1 through F8 in the left field. After 
you have edited the changes, click Put Function 
into Device to transfer the settings to the 
carillon. 

Buttons 1 through 4’s four-character (short) 
name are displayed on the lower line of the 
carillon’s display. These can be edited in the 
field to the right of the button pull-down 
selector. The Church Bell Remote mobile app 

uses the first two characters of the button’s short name to determine which 
icon to display for the function. The Mobile App Label allows you to give the 
function a more meaningful long name that will display beneath the button 
in the mobile app.  

Synchronize Clock 

The internal carillon clock can be synchronized to internet timeservers using 
the time zone you set in Windows on the host computer. If the checkbox for 
Automatically Synchronize Date and Time is selected, the time will set every day if 
the Management Suite is running and left at the main menu. Manual 
synchronizing can be done by clicking the button on this settings tab. If your 
network does not access the Internet and you have your own time server, the 
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Premium Management Suite’s Administrator options allow you to specify the 
time server’s address. 

Time Strike Melody 

Millennium carillons are not limited to the 
Westminster chime for clock striking. Use the 
pull down menu to select the melody you would 
like to use. If you select User Sel Strike, you can 
enter selection numbers into the four fields for 
each quarter. Any valid selection number will 
work. If you have the recording librarian, you 

can even play your own clock chiming melody on the keyboard 

Seasonal Options 

Use this panel to select the SmartAlmanac™ seasons you wish to use to 
automatically substitute seasonal music. In addition, you can select which 
music arrangements you would prefer the almanac to use when randomly 
selecting seasonal music on a Millennium carillon.  

Unless otherwise indicated below, if you say 
No to a particular season then the system 
will continue to play non-seasonal music. 
Except for Patriotic, the settings only affect 
the sacred seasonal random groupings listed 
on page 22. 

Make the settings described below then 
click the Put Seasonal Options in Device 
button to update the carillon. 

Automatic Daylight Saving Time 
Set this option to Yes if the system is to 

automatically set the clock forward and back for Daylight Saving Time. 

Use US Patriotic 
If this option is set to Yes then the system will play patriotic music on 
Independence Day and Memorial Day (all seasonal groups).  
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Play Lenten 
If this option is set to Yes then Lenten music for Grp1 and Grp3 selections 
will play from Ash Wednesday until Good Friday.  

Off on Good Friday/Saturday 
If this option is set to Yes then there will be no sacred seasonal music to play. 
If you have Grp1 or Grp3 selections programmed, the system will remain 
silent. If the option is set to No, the system will continue to play Lenten music 
on Good Friday and Holy Saturday.  

Play Easter 
If this option is set to Yes and the Marian season is also set to Yes then Easter 
music will play from Easter Sunday until the end of April. If Marian is set to 
No then Easter music only plays for one week. 

Play Marian 
If this option is set to Yes then: 

1. Marian hymns will play August 15 and 22, December 8, and the entire 
month of May. 

2. Catholic hymns will be selected for sacred music. 
If this option is set to No then: 

1. Non-seasonal music will play during the Marian seasons. 
2. Protestant hymns will be selected for sacred music. 

Play Thanksgiving 
If this option is set to Yes then Thanksgiving music will play on the Sunday 
preceding Thanksgiving Day and again on Thanksgiving Day. 

Play Advent 
If this option is set to Yes then Advent hymns will play from the First Sunday 
in Advent until the Christmas start date set below. In addition, the Advent 
setting determines when the Christmas Season ends. 

Yes – Christmas ends on January 5 (before Epiphany) 
No – Christmas ends on December 26. 
 

Christmas Start Date 
Christmas music cannot be disabled. Instead, the date Christmas music 
begins to play can be set from December 1 to December 24.  
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Use Pre-recorded Chime and Harp Arrangements 
If this option is set to Yes, the factory-supplied music using two part Chime 
and Harp music is enabled. If these are the only arrangements available and 
you set the option to No all factory supplied random music will be disabled. 
Disabling the Harp accompaniment can be selected in the Voicing Options tab 
if available on your carillon (Millennium Gold and Platinum Editions). 

Use Pre-recorded Full Carillon Arrangements 
If this option is set to Yes, the factory supplied music using the full range 
carillon music is enabled. If these are the only arrangements available and you 
set the option to No all factory supplied random music will be disabled.  

Zone Auto-Mute™ Settings 
Both automatic play (any music or bell ringing activated by the automatic 
schedule) and manual play (music or bell ringing activated by the remote 
control or Play Selections menu) can be set so that the speakers will operate 
inside only, outside only or both (inside and outside). 

Generally you would set the automatic mode to play either both or outside 
only. The factory defaults are to play both inside and outside for automatic 
and manual selections.  

Let’s say for an example, that you only wish the keyboard performances to be 
heard inside. That is, all non-keyboard bell-ringing needs to play outside only. 
To accomplish this, set automatic to outside, and manual to outside. Because 
these options do not affect the keyboard performance modes, only the 
keyboard will be heard through the inside speakers.  

When the system is playing, the green front panel lights will indicate which 
speakers are active. 

Voicing Preferences 

This option is only available on the Millennium 
electronic carillon systems. Set the musical voice 
for each arrangement style, clock striking and 
keyboard modes. 
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SCHEDULER 

With the scheduler, you can view, edit, and save multiple weekly schedules to 
your personal computer.  A schedule can be loaded into your carillon unit at 
any time.  

The text editing modes are useful for programming non-time strike events 
such as music and liturgical ringing such as Angelus and call to worship bells. 
The Time Strikes/Auto Levels modes are the best way to program time 
striking and set the playing volume for certain times of the day. 

Review the Weekly Schedule 

On the main Management Suite menu, click the Scheduler button to open this 
application. A standard menu bar is located at the top of the window.  Use 
the File menu to open and save schedules to your hard drive. Use the Edit 
menu to open additional panels for schedule editing and the Device menu to 
transfer data between the PC and the carillon. Data transfer can only be 
accomplished when the carillon is connected to your computer via the USB 
interface. Toolbar buttons can be used instead of the pull-down menus. 

 

 

 

 
 

 

Scheduler toolbar   

To open and view a schedule,  

1. Select New Schedule from the file menu for a blank schedule, or 
2. Select Open from the file menu to review a previously saved schedule, or 
3. Select Get Schedule from Device from the Device menu to see the current 

schedule. Detailed instructions for this are on page 31. 

Open Schedule 

New Schedule 

Edit Time Strike/Auto Level 

Save Edit Selections 

Get Schedule from Device 

Put Schedule in Device 

Get Titles from Device 

Show Title Catalog 

Exit Scheduler 
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Filter the Schedule Listing 
Click the right mouse button in the empty space of the schedule to set 
filtering options to view all time slots, slots with time-strike options, or times 
with other events programmed. 

 
Schedule with empty time slots hidden. 

 

The schedule window lists the day, time slot, programmable volume level, 
time strike mode, and selections for each quarter-hour of the week. Multiple 
schedules can be open at a time in the tabbed window-viewing environment. 
It is a good idea to name and save your file when starting a new schedule and 
to save often.   

Creating and Editing Weekly Schedules 

The schedule data is predominant in the Scheduler window and is used to 
select certain timeslots or view the current schedule file.  It is important to 
remember that the schedule you are working on is not loaded and active in 
the carillon’s schedule memory until it is put there (see Uploading Schedules to 
the Carillon on page 28). Keep in mind that someone else may have edited the 
schedule on the carillon since the last Scheduler file was uploaded into it. 
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A good habit to get into might be to get the active schedule (described on 
page 28) from the carillon and save it as “backup-(today’s date)” before 
making changes to it. 

 
Daily schedule editing in Edit Selectionswith title lookup. 

Selections 
You will notice four sets of “0000” for every quarter-hour under Selections in 
a new schedule listing.  These are fields that hold selections for anything 
other than time strike programs. If you are entering a specific song or bell 
ringing operation, the selection number is entered directly into the selection 
field.  You can also copy and paste the selection number using Cntl-C and 
Cntl-V. 

If you don’t want to begin ringing on the quarter-hour, a pause macro can be 
programmed to delay the beginning of the program. Pause macro codes are 
on the pull-down menu in each selection field. For example if you want to 
ring a swinging bell at 8:55, program an eight-minute and then a two-minute 
pause before the ringing code in the 8:45 time slot. 

To erase a selection in the text edit mode, choose the blank selection from 
the pull-down menu, or enter four zeros.  

The following Random Group tables show two different ways to program 
random music. You can directly enter a Grpn selection (using the pull-down 
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menu) for each random song, or choose a 70xy block macro code to play 
multiple musical selections in one selection slot. Since the numeric macro 
codes define how a performance ends, selections placed to the right of them 
will not play in the automatic schedule. 
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 SmartAlmanac
™

 Random Group Macro Codes 

Grp1 
Sacred hymns mixed with non-sacred music, follows the 
almanac seasons 

Grp2 
Sacred hymns mixed with non-sacred music, always non-
seasonal 

Grp3 Sacred hymns only, follows the almanac seasons 

Grp4 Sacred hymns only, always non-seasonal 

Grp5 
Non-sacred music only, will play patriotic and Christmas in 
season 

Grp6 Non-sacred music only, always non-seasonal 

Grp7 Patriotic music independent of season 

Grp8 Marian hymns independent of season 

Grp9 Custom User Group (See page 37) 

 

70xy Random Music Block Macro Codes 

x (Length of Block) y (Music Group) 

0 Plays four selections 0 Alternate Grp4 and Grp6 

1 
Plays until 5 min before 
next quarter hour 

1 Grp1 – Mixed 

2 
Plays until end of current 
quarter hour  

2 Grp2 – Mixed non-seasonal 

3 
Plays through current and 
next quarter hour 

3 Grp3 – Sacred Hymns 

 
4 Grp4 – Non-seasonal Hymns 

5 Grp5 – Non-sacred 

Note: 70xy codes must be the 
final selection programmed in a 
time slot. Subsequent selections 
will not play because the ending 
time of the macro corresponds 
to the beginning of the next time 
slot. 

6 Grp6 – Non-sacred, Non-seasonal 

7 Grp7 – US Patriotic 

8 Grp8 – Marian Hymns 

9 
Grp9 – Custom User Group 
(See page 37) 
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Edit Selections Panels 
Click the Edit Selections tool bar button or select it from the Edit menu. A 
window will open with a panel that allows you to change one time slot. Tabs 
at the top of the window allow you to select other methods of setting the time 
so that you can program multiple days, a range of time or only those time 
slots that you have selected in the schedule-viewing window. 

Although you can program changes to the time striking and volume levels in 
the Edit Selections panels, it is easier to do that in the Edit Time 
Strikes/Auto Levels mode described below. When you open a text mode 
editing panel the check boxes for level and time strike changes are unchecked 
to prevent unintended changes.  

Selections may be programmed in the lower portion of the Edit Selections 
panels. Up to four selections can be entered per time slot from left to right. 
To enter a numeric selection, click your mouse in the selection window and 
then type the four-digit selection number. The cursor will advance to the next 
selection window after you make the entry. To program macro codes for 
pauses and random music groups use the drop down button next to the 
selection window, and select the code.  

To erase selections you have entered, use the pull down button to select a 
blank entry. You should do this from right to left because the editing panel 
does not allow blank selections between programmed selections. 

Add new events to the weekly schedule 
Click the Edit Selections tool bar button or choose it from the Edit menu. In 
the daily tab, only the days selected and the categories selected (Chime/Strike, 
Level or Sections) will change.  Under Selections, you can type in a 4-digit 
selection, choose a Pause (Pau 1-8), choose to play a selection from a 
randomized list (Grp 1-9) or enter a macro function button code (793*).  
When the screen displays what you wish to change, click Change Timeslot(s).  
This present screen will not change but the master schedule behind it will 
show these changes.  

To use the selected tab, first highlight one or more times on the main 
scheduler screen.  Once you have the times you wish to change selected, 
choose Edit Selections and the Selected tab.  Again, only the selected categories 
will be edited.  This is also how you delete a time.      
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Make changes to existing events 
You should edit like timeslots together. That is, edit all of the call to worship 
(Mass) times, the Angelus times, and then all of the music times.  

1. Right click in the schedule list and select View slots with selections. 
2. Click line by line in the main viewing window to highlight timeslots.  Hold 

the control key while clicking with the mouse to combine your choices if 
they are not consecutive in the list. If they are consecutive, you can drag a 
selection box around them. 

3. Click the Edit Selections button.  A new window will pop up with tabbed 
panels that can be used to select timeslots and make changes.  Use the 
Selected tab to edit the existing timeslots you have selected above. 

 
Time Strikes/Auto Levels Editing 
 

 
Editing the weekly schedule in Time Strikes/Auto Levels mode. 

Time strike options and scheduled volume level changes can easily be set in 
the Time Strikes/Auto Levels edit mode. Click the Edit Time Strikes/Auto 
Levels button. This window represents each quarter hour of the week as cells 
of a grid.  
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White cells have the time strike turned off. The CHM (chime melody) mode 
is programmed in those time slots whose cells are colored light blue and have 
a musical note at the top of the cell. The STK (strike only) mode is 
programmed in those time slots colored yellow with a hammer at the top of 
the cell. These options are detailed below. 

Selected cells change to red when they are ready to edit. To select the times 
you wish to edit in Edit Time Strikes/Auto Levels, you may click single or 
multiple cells while holding [Ctrl] on the keyboard. You can click and drag a 
rectangular selection box around multiple cells to select a range of days and 
times.  

Quarter-hour selection check boxes at the top of the window enable or 
prevent quarters of the hour from being changed. This allows you to set only 
the top of the hour, or top and half for a selected range of time. Use the pull 
down menu to select the level or style of time striking and then click the 
Change Selected Timeslots button to modify the selected cells. 

After making changes you can deselect all selected times by clicking in the 
areas to the left or right of the grid or beginning a new selection without 
holding the Ctrl key. 

Volume Level 
Changing the volume level throughout a 24-hour day and on different days of 
the week can be accommodating to the surrounding community and 
compensate for changes in ambient noise levels (such as rush-hour traffic or 
early morning calm).  The outside speaker level can be set at 1-8 (quiet to 
loud), the default being 6. The level is shown on the Time Strikes/Auto 
Levels panel in as a bar graph with one to eight segments. 

Using one of the selection methods, enable Level and choose the desired level 
number from the pull-down list.  Repeat for as many changes in volume level 
that are needed at various times. 

Time Strike Options 
When CHM is selected, the clock-chime melody (Westminster Chime) plays 
on the selected quarter hour(s) and will be followed at the top of the hour 
with a toll of the hour.  When STK is selected, the top of each hour is 
marked only with a toll of the hour, and all other quarters are marked by a 
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single strike. When OFF is selected, no time announcement shall be rung for 
that particular quarter-hour.  

For example, it may be desirable that the Westminster melody and time strike 
be used every quarter-hour throughout the day, and at night, only have the 
top and bottom of each hour tolled on a lower volume setting to minimize 
noise in the community. 

Transferring Data to/from the Carillon 

Get Titles from Device 
Generally, you only need to do this once. After that, the Scheduler and 
jukebox functions will remember the titles available. Click the Get Titles from 
Device tool bar button or choose it under the Device menu.  You will be 
prompted to confirm; click OK.   

After a moment, a new window will be generated, displaying the available 
library selections. Depending on the system model you have, more than one 
list may be available under the Select Series pull-down. These are special 
ringing functions and musical arrangements for different bell voicings. 

The Show Device Titles tool bar button is used to view this library once it is 
downloaded. This feature is a useful tool when composing your schedule, to 
look up numbers for music titles and options. You can use copy (ctrl-c) and 
paste (ctrl-v) to put these numbers into your schedule editing fields. 

Uploading Schedules to the Carillon 
As you are composing a new schedule, it is a good idea to save the file 
periodically.  When it is finished, it might be a good idea to double check 
codes and settings and look over the Edit Time Strikes/Auto Levels  view. 

Connect the carillon to your PC. Open the Management Suite software.  
Notice whether the status bar indicates “Not Connected” or “Ready.”  

1. Click on the Scheduler 
2. Open the schedule you wish to load from where it was saved. 
3. If the system is playing, wait for it to finish, or press the [Cancel] 

button twice to cause it to stop and return to the standby mode. 
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4. The schedule you wish to load must currently be in view. If multiple 
schedules are open in the scheduler, click on the tab of the schedule 
you want to load. 

5. Click on the Put Schedule into Device button on the toolbar.   
6. One of the following panels will open. 

 

 
Free Management Schedule Storage confirmation – Click OK 
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Premium Management Schedule Storage window choices 

 

7. Premium Management Suite Only To store the schedule into active 
memory (the current weekly schedule), click Put Schedule in Device at 
the top of the window. Alternately, save the schedule in FLASH 
memory so it can be made active later when a macro selection code is 
executed. The macro selection number is displayed to the right of 
each Store Schedule to Macro button. The file names of previously 
stored schedules are listed to the left of programmed macro storage 
buttons.  

8. Premium Management Suite Only You can remove schedules from 
macros by selecting the check boxes on the left side of the Storage 
window and click the button at the lower left of the window. You do 
not have to clear macros before replacing them with new schedules. 

 
Managing Multiple Weekly Schedules 
Premium Management Suite Only 
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Up to ten weekly schedules can be stored in FLASH memory to be 
transferred to active schedule memory when the associated macro code is 
executed. The macro code can be programmed anywhere a selection number 
is normally entered. It is generally not a good idea to place these schedule 
activation codes in a weekly schedule unless it is a temporary schedule and 
you want to replace it with a default later in the week. 

Typically you will have a schedule for various times of the year. The one-time 
or annual event schedules are the logical place to program the schedule 
transfer macros at the appropriate time. The macro codes are 7930 – 7939.  

Any edits made to the active schedule either from the system front panel 
editing screen or with the Scheduler application will not affect the copy in 
FLASH memory. The next time a macro overwrites active memory, changes 
will be lost if they are not saved with the Scheduler application. No provision 
is made to transfer a schedule to FLASH except with the Scheduler 
application. 

Get Schedule from Device 
Click the Get Schedule from Device tool bar button or choose it under the 
Device menu.  You will be prompted to confirm or choose to retrieve a macro 
schedule. A new window will display the current schedule.  

It is not saved automatically, but will prompt you to save it to a file when 
closing the window before saving.  
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SPECIAL EVENTS 

Premium Management Suite Only  

Special events are times you want the system to play automatically, but not on 
a weekly basis. A favorite song can be used to commemorate an anniversary or 
other special occasion. Ringing for a special service that will not be repeated 
can be programmed in advance. Annual or One Time events can also be used 
to execute macros to transfer weekly schedules from FLASH memory to active 
memory. 70xy codes cannot be entered here.  However, you can use macro 
function codes (793*)  

Events programmed at the same time will occur in the order they occur in the 
list. The list can be sorted by either double clicking the column headings or 
selecting events and pressing [Ctrl]+[cursor Up] or [Ctrl]+[cursor Down] keys.  

Annual Events 
A month, date, time and a selection number define a typical annual event. In 
addition to hard dates, you can also define a day in the first, second, third, 
fourth or last week of the month.  

One-Time Events 
Any selection can be programmed to play once for special events or 
memorials. One-time events are programmed exactly like the annual events 
with the addition of an input field for the year. 
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CREATING CONCERTS 

The Jukebox app lets you create and save play lists that can be used for special 
events and concerts. It is much more flexible than the carillon’s built-in 
manual mode. 

Getting Started 

Connect the carillon unit to your PC, and then open the Management Suite 
program.  Note whether “Ready” status is indicated.  Click the Jukebox 
button to open this feature. If the carillon is not ready, either wait until the 
automatic operation is finished, or open the Remote Control panel to cancel 
the current operation (or press the red Cancel button on the front panel 
twice if it is within convenient reach). 

 
Concert Playlist 

 

If the right pane in the Jukebox window is empty, you need to get the library 
listing from your carillon unit.  Go to Titles - Get Titles from Device or click the 
button on the tool bar.  It should display the list momentarily. Once the Title 
list is downloaded, you may select the type of music available from the Titles 
pull-down above the list. Familiarize yourself with the menus and available 
options. Context menus for each pane are available with a right mouse click. 
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Building a Play List 

A play list must be created before any music or special functions can be 
played by Jukebox.  You can save play lists for different occasions in separate 
files. 

Searching for Titles 
If you know any part of a selection title or number, the find tool makes them 
easier to locate. Open the Find window from the Edit menu or by pressing 
[Ctrl-F]. 

 
 

The Find tool in Jukebox makes searching for titles easier. 

 
In most cases search results will appear at the top of the window, however, 
one or more will be visible with a gray selection number at the current 
position of the list.  Closing the Find window will show the found selection in 
a higher contrast color. Clicking Find Next will search to the next occurrence 
of the search text. 

Adding Selections 
Once a desired title is found, you may simply drag-and-drop the number into 
your play list from the current title list.  Copy and Paste can also be used by 
right mouse clicking in the appropriate list, using the toolbar buttons, Edit 
menu, or [Ctrl+C] (copy) and [Ctrl+V] (paste) on your keyboard.  Keep in 
mind that multiple selections can be highlighted before bringing into the play 
list window by using [Ctrl] and/or [Shift]. 

Note that only the selection numbers are highlighted when selections are 
marked. Selections can be repeated in the play list any number of times. 
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Moving and Deleting 
Selections can be added to the play list in any order.  Re-order the play list 
using the Move Selections Up and Move Selections Down buttons.  Another easy 
method is to use [Ctrl] and/or [Shift] to highlight selections, and then click 
and hold left-mouse while dragging to any position on the list where you wish 
to drop them.  Selections will be grouped together in one block, in the same 
order they first appeared.  Note, however, that the move up and down 
commands keep the original number of “gaps” between multiple, spaced 
apart selections when moving, whereas dragging with the mouse lumps them 
together. 

Another way to change the order is to double click the column headings to 
sort by selection number or title. Re-ordering in this way does not flag the file 
for saving (by putting an asterisk next to the file name). You must 
intentionally save the sort order if you want to keep it. 

The delete function (“X”) will take any and all selected titles off of the 
currently open play list.  There is no undo for deletions. 

Create Title 
There may be cases when you wish to rename a selection to something more 
familiar or create a personalized description. Click on Create Title in the 
toolbar, enter the appropriate code number, enter your new title, and type the 
series it belongs to if you wish. The new title and selection number will 
appear only in this play list.  

Play Menu and Options 

The three play controls are Play, Next Selection and Cancel All. You can also 
start playing the playlist from the carillon remote control or app if the playlist 
is displayed in the active Jukebox window. 

Play Mode 
Pull down your choice of All or Selected.  For the latter, if you wish to only 
play certain selections from the chosen play list hold [Ctrl] and/or [Shift] on 
your keyboard to help highlight the selection numbers you want to play.  
Note that if Play Mode – Selected is active, but no selection numbers are 
marked, clicking Play will have no result. 
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Random Shuffling and Repeat 
The Random button plays the list in random order so no selection plays twice 
until all have been played.  Click the Repeat button to keep repeating the 
current play cycle.  Both of these buttons are highlighted as long as they are 
active, and both can be used together. When both are selected, the random 
order will change every repeat cycle. 

Selection Advance, Stop, and Closing 
The Advance button is clicked to cancel the current selection being played and 
begin playing the next selection. To cancel the entire concert, click the Stop 
button. 

If you close the Jukebox window during playback the concert will conclude 
after the current selection has completed.  

Remote Activation 
When a playlist is open in the active window, the PLAY button on the remote 
control will activate the current play mode. Pressing the STOP button once 
will cancel the current selection and begin playing the next selection. Pressing 
the STOP button to cancel the current selection, then pressing immediately 
again will cancel the remainder of the play list. 

Viewing Options 
Premium screen mode can be selected from the View menu and serves as a 
large sign for passerby to see what is being played in a kiosk situation. This 
screen is customizable from the Change Full Screen Look panel of the View 
menu. Right-click to exit full screen mode or press [Esc] on your keyboard. 
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LIBRARIAN FEATURES 

Full Management Suite Only 

Custom User Group Nine 

The Chime Master contains a database for eight categorized lists of music that 
are suitable for various times of year. In addition, a century of moving 
liturgical dates is included so the system knows which music lists to use. We 
call this feature SmartAlmanac.™ Using the Custom Grp9 librarian feature, 
you instruct the carillon what music you would like to hear during the 
following seasons as well as non-seasonal times.

US Patriotic 
Lent 

Good Friday 
Easter 

Marian 
Thanksgiving 

Advent 
Christmas 

 
Other groups can be scheduled in addition to Grp9, but you will probably 
want to make it your exclusive music group if you want to insure that the 
system only plays the music you prefer.  

Seasonal Play Lists 
The User Group Nine feature looks and works very similar to the Jukebox 
feature. The left pane of the window is where you will build the random play 
list for each season. The required number of songs you place in each season 
depends upon the number of selections you play each day and how much 
variety you want. We recommend at least six selections per season. 

Building the Play Lists 
After opening the User Group Nine window, select a season from the pull 
down menu. You should see a list of music in the right pane. If you don’t see 
them you can get the title listing from the carillon using the Titles menu. 

All of the features used to build the Jukebox playlist are available in the 
Group Nine librarian, including title searches, and drag and drop editing (see 
page 34). 

If your carillon supports more than one type of arrangement, you can pull 
down either Chime and Harp or Full Carillon music arrangements from the 
Device Titles menu. You can mix the arrangements in the play list, but try to 
choose the arrangement you prefer for each song.  
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Do Not Leave a Season Blank 
If you leave a season blank and do not disable that season in the carillon’s 
seasonal options or do not use another random group to schedule music, the 
carillon will not play any music at the scheduled time. If you wish to continue 
to play non-seasonal music for Group Nine during one or more of the other 
seasons, copy all of the selections from the non-seasonal list to the seasonal 
list. To do this, open the Non-Seasonal list, then click on the first selection 
number to select it and press [Ctrl-A] (select all) to select the entire list. Press 
[Ctrl-C] (copy) to copy the list of non-seasonal selections. Now select the 
season you wish to copy the music to, and press [Ctrl-V] (paste) to add the 
selections to this season. 

Adjust Tempo for a Song 

This feature affects MIDI sequence files stored in the Millennium carillon. It 
cannot be used on the Model Six because it is not a MIDI based instrument. 
It also does not affect MP3 files stored on an optional SD card. 

Adjusting the tempo of swinging bells will break them. Don’t do it. 

Transpose a Song 

This feature affects MIDI sequence files stored in the Millennium carillon. It 
cannot be used on the Model Six because it is not a MIDI based instrument.  

We do not recommend transposing Chime and Harp selections because they 
utilize a split-keyboard. Transposing these selections up may result in 
accompaniment notes playing on the lower chimes. Transposing down may 
cause melody notes to play on the harp bells (or disappear if harp bells are 
turned off). 

Transposing swinging bells and peals will break them. Don’t do it. 

Load SD Titles 

If the carillon has an SD card option, you can load MP3 files onto it and play 
them by the number given in the file name (see the carillon operating 
manual). If you would also like to see the titles appear in the Management 
Suite title lookup (and in the onscreen carillon listings), they can be entered 
with this feature. 
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As titles are added to the list, it automatically sorts in alphabetical order. Each 
card’s titles should be saved to a separate file. 

Buttons on the left side of the window select one of six cards the titles 
represent. All six of the cards can be stored in memory simultaneously, then 
you change which one is active when you change cards without having to 
reload the titles. 

Recording Librarian 

The Recording Librarian is a specialized remote control panel for the Record 
option on the Millennium carillon. You should be familiar with making 
recordings using the Millennium keyboard before using this application. The 
menu button for the Recording Librarian will not appear unless your carillon 
has the factory installed record option, and the Management Suite is installed 
with a Premium license. 
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Record a Performance 
Clicking the Record a Performance button (which changes to Go to Standby) 
activates the record menu and places the carillon in the rehearsal mode. 
Automation is suspended while the record menu is active. If you wish to exit 
the record menu to resume the automatic schedule, press Go to Standby. 

The keyboard is active for practicing through the inside speakers only. If you 
wish to play through the outside speakers, you can click on the Outside 
indicator. The Volume Up/Down buttons allow you to adjust the level of the 
inside monitor speaker.  

The bell voice that will be used for the recordings is listed at the top of the 
blue display screen. To select alternate bell voices, click the Keyboard On/Voice 
Select button. 

The Record button enables the carillon for recording from the keyboard. If 
you do not begin to play the keyboard within 10 seconds, the recording will 
cancel. If you have previously recorded something into the temporary memory 
buffer without saving it, the system will ask you if you mean to Replace the 
Last Take. If you mean to erase the last recording without saving it, press Yes 
to continue. 

The Play button allows you to review the temporary recording buffer 
(selection 8000).  

The Save button transfers the recording from the temporary memory to 
permanent read only memory and assigns the recording a selection number. 
This takes a little time and when complete, the selection will appear as 
Untitled at the end of the selection listing. The system returns to the 
automation standby mode after saving a selection, so you will have to click 
Record a Performance to return to the record menu. 

Title and Categorize Your Recording 
If you title your selection, it will be available in the title lookup for the 
Jukebox and other music library applications. To process the song you have 
just recorded, select the last selection in the list by clicking on it. If you can’t 
remember what it was, right click it and select Play (from the pop-up menu, 
not the button at the top) to audition it. 
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Click the Enable Changes checkbox to allow editing. Double click 'Untitled' to 
open the Title Text field, and type the title of the selection (up to 20 
characters). Double click the item in the Random Play field to select an 
almanac season to add the selection to (unless you wish to add it to the User 
Group 9 list). When you have finished titles and categories for all of the 
selections you wish to change, click Save Changes to Device. 

Import a MIDI file 
Instead of using the Record function to capture a performance on the 
keyboard, you can import a MIDI file. This file has to be saved from a 
notation editor or sequencing program in a format that is compatible with 
the librarian: 

MIDI format 0 file (single track) 

 

Only the tempo given at the beginning of the file will be used, tempo changes 
are not supported. 

Open the Recording Librarian application and select Import MIDI 0 from the 
file menu. You can either navigate to where the midi file is, or drag it into the 
Open file dialog. The song is imported into the temporary recording buffer 
(selection 8000) overwriting any selection contained there. Make sure you 
save the last recording before importing or recording a new one. 

To audition the song, click the Play button. You can change the voice it plays 
on by clicking the Keyboard ON/Voice Select button. You may have to 
transpose the selection in the sequencing software to make it sound right on 
the bells. When the selection sounds the way you want it, click on the Save 
button and it will be added to the list of recordings as Untitled. 
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REMOTE CONTROL 

This feature of the Management Suite looks and operates very similar to the 
front panel of your carillon.  The keypad operates the same, and the display 
will show exactly what appears on the carillon panel. You can remote control 
the carillon by using this screen. 

Click the Remote Control button on the main menu to open the remote 
panel shown below. Refer to the Carillon operating manual for operational 
features and menus.  

 
Remote Control works as if you are in front of the Carillon. 

 
Avoid using this remote panel while playing from the MIDI keyboard. The 
Recording Librarian screen (page 39) can be used instead for best results. If 
you need all of the features of the remote control panel before and after your 
performance, we advise that you freeze the display screen by clicking on it 
while playing the keyboard. The area around the display will turn gray to 
indicate that the screen is not updating. 

An alternative to mouse-clicking buttons in the Remote Control is to use your 
computer keyboard.  Refer to the following table for these shortcuts: 
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Remote Control - Computer Keyboard Shortcuts 

Carillon Keypad button PC Keyboard button 

0 0 

1 1 

2 2 

3 3 

4 4 

5 5 

6 6 

7 7 

8 8 

9 9 

Cancel/Stop Esc 

Enter/Play Enter/Return 

Cursor         

 End (to Exit) 

 
Control from Anywhere 
In addition to the smart phone/tablet app, Splashtop.com, Team Viewer, 
GotoMyPC.com and LogMeIn.com are additional resources for remote 
control software that allow you to control the carillon from other computers 
and mobile devices. 

 You can customize the button sizes for fitting your touch-screen tablet or 
smart phone that you use to remote into your system. Use the Button Size and 
Button Layout options under the View menu to arrange the buttons to fit your 
screen. 



44 

UPDATE FIRMWARE 

This feature is used to update the firmware in your Carillon unit. The latest 
standard firmware is included with each release of the Management Suite 
software. 

If customized features have been installed on your system, or foreign language 
support, these features may be lost if you update your firmware with the 
standard firmware supplied. Call if you are not sure if you need to update. 

After launching the update application, click the Update button in the 
window. All of the update files that are applicable to your system will be 
displayed. The last four digits indicate the revision number and year of release 
in the format RNYY. Use the highest revision number of the most recent year 
when you select the file. 

If we email the firmware update file to you, save the attachment to your 
desktop, and then drag it into the Open file dialog windows so you can select 
it. 

UPDATE LIBRARY 

Instructions for updating your library will be supplied along with library 
update files. 

If a library file is emailed to you, the easiest way to get it into the 
proper folder for the Management Suite is to click on the Update 
Library button, then drag the files into the file dialog screen. 
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BACKUP 

You can perform various backups of important files and settings using this 
feature. 

 
 

Schedules, setup data and user recordings can be backed up all at once or into 
separate backup files. 
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